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Cleo Transaction Designer for XML User’s Guide Introduction

Introduction

Cleo’s Transaction-based Processing has been extended to allow transadi®ns
created using XML documents, in addition to TN3270 and TN5250 screens.
Traditionally, programs that access XML data retrieved from various sostegdsas
database front ends, web services, and custom server applications, geelgraih XML
navigation tools such as XSLT, XPath, or XQuery. Although these tools are effective
they represent a level of programming complexity that often requires alsgiedCleo's
Transaction Development Kit provides a simplified mechanism for defining and

processing custom XML "transactions."

XML based transactions are created using a simple GUI interface tatmgibich XML
documents are included in a transaction and which fields contain input or output data.
These transactions contain all the information necessary to interact witbf ax84L
documents. Thus, once transactions have been created, the developer can send and
extract XML data using fewer calls than traditionally required. Thipkiies the
development process that in turn leads to reduced development time and higher
reliability. The GUI interface may be used by any developer, including tradamiliar

with the details of exchanging or managing XML documents.

The Cleo Transaction development kit is composed of:
0 A Transaction Designer™TD) — that captures XML documents and creates
transactions.
0 A Transaction Processor™TP) — that processes the transactions in real time
and provides the basic API functions.
0 An Administration GUI- that provides a Configuration tool and an

Administration tool for the Transaction Processor.
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The documentation set that supports the development kit consists of the following:

Quick Start Guide for Transaction Designer

This guide lists prerequisites and provides an installation procedure for thactiams
Designer.

Cleo Transaction Designer for XML User’s Guide

This guide explains how to capture XML documents and create transactions.
Quick Start Guide for Transaction Processor

This guide lists prerequisites and provides an installation procedure for thactiams
Processor.

Administration Guide

This document describes the web-based administration utility for the Tramsacti
Processor product.

Programmer’s Guide

This guide provides information about developing applications using the Transaction
Processor.

This manualTheTransaction Designer for XML User’s Guidmntains the detailed

instructions for using the Transaction Designer.

The intended audience for this document is presumed to be familiar with application
development on a Windows platform, as well as having some knowledge of using XML

over HTTP for accessing applications running on a remote application server.

The Transaction Designer is a plug-in to Eclipse, an open-source development

environment. Although not required, some familiarity with Eclipse may also be .useful
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Overview

The purpose of the Transaction Designer is to allow a user to define transadtoma w

simple GUI based environment.

Consider the following exchange where XML is used to retrieve an accountdalanc

* Alogin request XML document containindagin id andpasswordis
sent to the server.

* Aresponse XML document is received from the server indicating whether
or not Login wasuccessful

» If successful, a balance inquiry request XML document is sent to the
server containing theccount numberandpassword

* A balance inquiry response XML document is received from the server

containing araccount balance

The Transaction Designer allows the user to take the XML documents used in this
sequence and group them together into a single transaction that can be executeel from
Transaction Processor. In documents sent to the host, elements or attributes can be
designated as Input Fields (dapin id, password. In the document received from the
host, elements or attributes can be designated as Identifiers (Used fy mleiotument
correctly) or Output fields (e.@ccount balance. Grouping these documents into
transactions significantly reduces the effort needed to modify a document tat be &e

host and to find the data in a document received from the host.
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Component Descriptions

Application — User-defined program that invokes the TP through the
Connector.

Application Server —System that runs the application that exchanges XML
messages with the TP over HTTP.

Connector (API) —Provides the programming interface into the TP.
Transaction Designer (TD) -Allows the user to define the properties of each
incoming and outgoing XML message that make up a transaction. Generates
the transaction set that can then be used by the TP to interact with the
Application Server.

Transaction Processor (TP) -Companion runtime component to the TD that
provides the transaction based processing of 3270/5250 screens and XML
messages.

Transaction Sets -Contain the information (XML document definitions and
transactions) required by the TP in order to recognize XML messages deturne
from the Application Server, parse the XML messages for output, and
generate XML messages populated with user supplied input to send to the
Application Server.

XML Documents —represent the actual XML messages exchanged at
runtime. These documents may pre-exist (or can be recorded by the TD) and
are then imported.

3270/5250 Mainframe host providing access to 3270/5250 applications.
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Key Features

The Transaction Designer provides:

o O O o o

A way to create transactions using imported XML documents.

A way to capture XML that is exchanged with a remote application.

A display of imported documents that can be used to create transactions.

A means to modify transactions.

A means to publish XML document definitions and transactions to files for use by

the Transaction Processor.

10
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Using the Transaction Designer

This section describes how to use the Transaction Designer. It includes how to:

» Use the Menu Bar and Toolbar

* Run the Transaction Designer

* Record XML Documents

e Import XML Documents

* Create a Transaction

* Publish a Transaction

e Transfer a Published Transaction Set
* Modify an Existing Project

* Modify an Existing Transaction

Transaction Designer Workbench

The Transaction Designer workbench is made up of\aethisandperspectives A view
is a tabbed window on the workbench that allows the user to view, navigate, and modify

the resources used in the project.

----- & GatCity
P <}==~{> bwoBlocks
- <}==~{> halidays

Figure 1: Transactions View

11
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A collection of views in the Transaction Designer is referred topgsspective A
perspective can also be thought of as a mode of operation. In the TD, there are two
perspectives or two different modes of operation. These two perspectivelear¢hea
“Designer Perspective” and the “Recorder Perspective” and allow theoussrdmplish
different tasks in the TD. The “Designer Perspective” is where XML dentsrare
grouped together to define transactions, while the “Recorder Perspgxtivedes the
user with a mechanism for capturing XML documents received from a hodt. Eac
component of the “Transactions Perspective” and the “Recorder Perspegtive a

described below.

Transactions Perspective

45 Transaction Designer - test = IElliI

1 =}
File Edit Project ‘Window Help
Jew| & O G| W] %
2 EE Designer
| =08 2 ansaction &3 : Jl_ | = O ||= Request &2 lResponse| =8
3 7 s
12 13
4
. Transactions &2 l =0 6
5
(7)Rules 3'3‘ i =8
1C 11
9

Figure 3: The Transactions Perspective

1. Menu Bar: provides access to the main functions and is described in the next

section.

12
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2. Toolbar: provides access to common functions and is described in the next
section.

3. Perspectives Bar:allows the user to switch between the Designer perspective
and the Recorder perspective.

4. Imported Docs View: Any XML documents that are imported are displayed in
this area.

5. Transactions View: Open transactions are listed here.

6. Transaction View: Displays a representation of the selected transaction in the
form of a tree containing the Request and associated Responses.

7. Graph View: Displays a representation of the selected transaction in the form of
a graphical chart showing the flow of the transaction.

8. Content View: Displays the raw content of the XML that the selected imported
doc, request, or response originated from.

9. Rules View: Provides a means to create rules to tie together transactions in
sequence based on output field values. See sectiGneating Rulesor more
details.

10.Branches View:Provides a means to create rules used to tie together
transactions in sequence based on the response received from the host. See
section orCreating Branchedor more details

11.Problems View: Lists errors contained in the current project.

12.Request View:Shows the details of the selected Request in a tree form. In this
view, the user can designate certain elements or attributes of the docament a
Input Fields.

13.Response ViewsShows the details of a Response in a tree form. In this view,
the user can designate certain elements or attributes of the document as Output

Fields or Identifiers.

13
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Using the Transaction Designer

Recorder Perspective

t’ Transaction Designer - RecorderTest

File

= Rgpnrd Esigner

Edit Project window Help

|| E O 1 | G|

2

=18l

R sy

ml
HolidaysMonthRequest.xml
| HolidaysMonthRespanse. xml
HolidaysyearRequest . xml
HolidayYearResponse. xml

=] CurrencyRequest. xml

CurrencyResponse, xml
StockRequest.xml
StockResponse.xml
EnglishToSpanishRequest.xml
-| EnglishToSpanishResponse. xml
-| ZipToCikyRequest.xml

| |[=]| ZipToCityResponse. xml

3

|

Haf

P

Re:

B HTTP 82 | MG | Sockets =i

8] Recorder £3 ‘

il

Send HML | Impork Request

mal

—

Fart

SOUrCE
Mew Save

| Conneckion Mame -

4

MationalBank.
HolidayByYear
HolidayByMonth
CurrencyExchage

BiblePassage

StackQuote =
f = |
Delete ModifyHeaderl

Kl

Impott Responise: | Clear Response

L]

o

1. Imported Docs View: Displays a list of XMLdocuments that can be used to

create transactions.

2. Recorder View: This view contains two windows. XML to be sent to the host

appears in the upper window by either clicking on an imported document or by

pasting XML into the window. When the send button is pressed, the response is

displayed in the lower window.

3. Hittp View: This is where connections to servers along with any associated header

information and/or resources are configured for Http.

14
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Menu Bar Descriptions

The menu bar is located at the top of the layout and provides the following functions:

File

|File Edit Project W

Mew, ..
== Cpen
E_'a] Save

|H Save As...

Exit

New: Create a new Project

Open: Open an existing Project

Save:Save the current Project

Save as:Save the current Project under a different name

Exit: Exit the application

Edit

|Edit Project Wi
| ¥ Delete
Delete: Deletes the selected transaction, component of a transaction, or imported

document.

Project
Project  ‘Window Help

=g Import ¥ML dacument or DTD

<,}==5 Creake Mew Transackion

[ ] Add Blodk

<= Add Response
. Add Request

Ll Publish Transactions

LT’.EI Transfer Transackion Set

Import XML document: Imports an XML document to be used in transactions for
the current Project.

Create New Transaction:Creates a New Transaction

15
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Add Block: Adds a Request / Responses Block to a Transaction.

Add ResponseAdds a Response to a Transaction.

Add Request: Adds a Request to a Transaction.

Publish Transactions:Publishes Transactions for use by the Transaction Processor.
Transfer Transaction Set: Sends the current Transaction Set to a specified local

folder or remote server.

Window
Open Perspective

Window  Help

Open Perspective > SR ERERaEE

Recorder

Shiow Wigw »

» Transactions the default perspective upon opening the Transaction
Designer. In this perspective, transactions are created and defined.

* Recorder: Changes the perspective from Transactions to Recorder. The
recorder allows you to capture XML documents as they are passed to and
from a server. To go back to the main Transaction perspective, click

Window > Open Perspective > Transactions.

Show View

Window  Help

Open Perspective I
Show Yiew d — Request
<0 Response

P =0 <~}=={'>1 <,}==f> Transactions

<.}==§> Transackion
<.}==“:> araphical
= Imported Docs

=
(7) Branches

Fy

(7) Rules
|2 Problems
Recorder

% Hitp

Show view restores views or panels if they are closed and brings the selested vie

into the forefront.

16
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Help

Help
Abouk

About: Displays product, version, and manufacturer information as well as licensing

information.

t, About Transaction Designer

Cleo Transaction Designer
Version 4.0.1

wWww cleo. com

© 2005, Cleo Compromicationes. 411 Fights Feserwed.
Transaction Desigrer is 4 tradenards and Cleo is a registered Tradernar
of Cleo Corrarnmications.

Host ID: Test Host
User ID: jdoe
Serial Mumber: 12345
Expiration Date: . permanent

Toolbar Descriptions

The toolbar provides access to common functions.

T
i | Import XML Document

& .
Create a new transaction

L] Add a Block to the current transaction

= Add a response to the selected block

= Add a request to the selected block

Al Publish transaction

® Delete item

| Switch between Transaction perspective and Recorder perspective.

17
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Perspective Bar Description

ﬁ EE Designer

The Perspective Bar provides another means to switch between the Transactions

perspective and the Recorder perspective. See “Transaction Designer Wdrlktench
an explanation of Perspectives. To switch from the current perspective to a new

perspective, click the Perspective Icon and séicer.

%’ EE Designer

S

Choose the desired perspective and dhék

*:, Select Perspective El

EE Diesigner (default)
| |recorder

18
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License the Transaction Designer

Without a valid license key, you will not be able to save or publish transactions.

Invalid /Expired License |

The license is invalid or expired. The TD will conkinue to run, but you will nok
be able ko save or publish,

To begin using all the functions of the Transaction Designer, you will need to obtain a
license key. If you do not already have a key, esa@dsEN@cleo.cono request

your license key. You will need to provide your host id, user id and serial number. To
obtain this information, open the Transaction Designer and in the File menu, click on
Help > About.

Once you have received your license key, save it in the following location:
%XTD_HOME%\plugins\com\cleo.td_4.0.0

(e.g. C:\TDesigner\plugins\com.cleo.td_4.0.0). The Transaction Desigheowibe
fully functional.

19


mailto:salesEN@cleo.com

Cleo Transaction Designer for XML User’s Guide Using the Transaction Designer

Run the Transaction Designer

Project files contain useful information about which transactions are defined and othe
properties such as last published date.
Note: All Project files have a .cxp extension and are stored in the associatedtioansac

directory (e.g. C:\Tdesigner\trans\test123).

Create a New Project During Startup
1. Open the Transaction Designer. A project menu screen will appear.

2. Enter a project name and cli€K. You will then be taken to the main

Transaction Designer screen.

P Select A Project...

Select a praject from the lisk and click "Select”
ar click "MNew" to create a new transackion sek

Project name | Lask Modified |

CIREn et | Delete | Cancel

Enker a name for the new project

0] 4 |

Open an Existing Project During Startup
1. Open the Transaction Designer. Existing projects will appear under the

Project Nameheader along with their associateast Modified dates.

2. Select the desired project and click Opemlouble click the desired project
name. You will then be taken to the initial Transactions perspective of the TD
Workbench.

20
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#2.Select & Project...

Select a project from the lisk and click "Select”
ar click "Mew" to create a new transaction set

Praoject name | Lask Modified |

':'F"F[' | e | Delete | Cancel

Wy

Enkter a name For the new project

| OKl

Open a Project After Startup
1. In the menu bar choosgéle > Open.

2. Afile browser window will appear that displays the default location for your

project files. Select the appropriate project you wish to open.

21
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Delete an Existing Project
In the event a project is no longer needed. It can be deleted.

To delete a project:

1. Open the Transaction Designer. Existing projects will appear under the
Project Nameheader along with their associatesst Modified dates.

2. Select the project you wish to delete and chekete

FL.select A Project...

Select a project Fram the list and click "Select”
ar click "Mew" ko create a new transackion set

st Modified |

Project name I

CIpen 1= | DEhI:'(EE | Cancel

e

Enter a name for the new project
| oK |

3. You will be asked to confirm your request to delete the project. @ksk

Delete Project? x|

@ Celete Project kest1237 All information will be lost,

| h"{'es I Mo
b

22
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Cancel
Click Cancelto exit the Transaction Designer

F:,l_._.SEIEI:t A Project...

Select a project from the list and click "Select”
ar click "Mew" ko create a new transaction set

Project name | Last Modified |
3L test123 0 0S5/02{2005

CpEn e | Delete | Canﬁl |

Enter a name for the new project

(8]4 |

23
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Import XML Documents

45, Transaction Designer - test456 O] x|
File Edit Project Window Help

Jes [ & 0 QoM %
ﬁgEDesigner

BB Imported Docs X = 8 || Transaction &2 ]Graph | Content| = 0O || = Request &2 lResponse| =0
5. Transactions 52 =0
(7) Rules 53 lBranches | Problems| =8

To import an XML document:

1. Click on the Import buttor,',ilﬂ .

2. Browse to find the location of your XML document and click Open. The file
will appear in the Imported Docs view.

24
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5, Transaction Designer - test123 o ]

File Edit Project Window Help

Jew | E 0o | W] %

%} EE Designer

EElImparted Dacs. X i <.}=="‘>Transaction 8 ]Graph | Content| = 0| = Request 2 lResponse| =0
| [Z] logir, xml

5. Transactions 52 =0

() Rules &2 lBranches | Problems| =8

Record XML Documents

If the XML documents exchanged with the server are not available for impor (ile. i

format), the Recorder can be used to save the required XML documents to disk after an
interactive session with the server.

25
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Access the XML Recorder

To access the XML Recorder, in the toolbar, click on the perspectiwﬁ [amd

chooseOther > Recorder, or from the menu bar chood&jndow > Open

Perspective > RecorderThis switches the TD to the Recorder perspective.

- R 5
T Transaction Designer - null

1Ol x|
File Edit Project ‘Window Help

s | E 00| M|
5 | @ Recorder EEDesigner

|{Zimparted Does 22 | = O m =0
- IE login. xml -
= logout, xml _I
-
Kl E
EoHtR iR (Mg = O
Send ZL | Impatt Reguest
Mame I
=l
IF I
Part I
Resource I
Mew | Save |
I Connection Mame
-
d |l |l L »
Delete | Iodify Headerl Import Response | Clear Response

Import or Select an XML Document to Send
To begin the recording processport an XML document (see “Import XML
Documents”) or, from the Imported Docs vieselectan XML document that you

wish to send to the server. The raw XML will appear in the top text pane of the
Recorder view.

26
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& Transaction Designer - null _1Ol x|
File Edit Project ‘window Help

|ew| & O oo | W] R
| @ Recorder EEDesignﬂ

Recorder &3 =0

vl version="1.0" encoding="UTF-5"?= d
<I-- DOCTYPE screenset-transaction --=<screenset version="2.0">
<screensekname value="logout” | >
<requesk:
<screenname value="FirstScreen, 1" =
</request>
<lscreenset =

Kl
LoHTTR 32 (Mg | ™ T O

Send XML I Impart Reguest
Name I
IF I
Part I
Resource I

Mew | Save |

| Connection Mame

ST ER e _>Iﬂ

Delete | TodiFy Headerl Impork Response | Clear Response

L

Optionally Edit the XML
If needed, you may edit the data within the top text pane by either typing dirgctly

the text pane or cutting and pasting text into the text pane.
Note: If you make a change to the XML document that renders it not well-formed,

such as leaving out an angle bracket, the text will change to red and the Send XML

button will become disabled. Fix the error and continue.

27
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Optionally Import XML Request
1. To save the modified XML as an imported document (for later use in a

request), click ommport Request.

2. Name the request and cliCkK .

S Enter Name For Request x|

Enter a name For this requesk

K I Cancel

Lx
3. The request will appear in the Imported Docs view.

Create an HTTP Connection
In order to send XML over HTTP to a server, the connection information for the

server must be provided. Connection information includes the IP address, Port, and
optional Resource (which is the relative location of the application on the server).

To create an HTTP connection:

1. Click on the HTTP view at the lower left, if it is not already displayed.

2. Enter aNamefor the connection. This name will appear in the “Connection
Name” box near the bottom of this panel and is used only as a means for you
to distinguish your connections.

Enter thelP address
Optionally enter the Port.
Optionally enter the Resource (e.g. ending URL path).

o g bk~ w

Click Save This saves the connection and will make it available for all

projects.

You may continue to create additional connections by clickieqy. A dialog box
will appear asking you to name the connection. The connection will then appear in

the selection list. Select the connection to define the settings as above.
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Delete an HTTP Connection
To delete a connection, select the connection name by clicking on it, and then
click Delete

Modify HTTP Header
All HTTP connections include a header. Should you need to modify the header,

click Modify Header. Add the desired field names and field value pairs to the
HTTP header. This is an optional tool.

i ¥iew Modify Header x|
Field Mame I Field value |
SOAPACkon

add | Celete | Save Cancel

Send XML to the Server
Once the XML document has been selected and your connection has been created,

you can send the data to the server.
1. Choose the connection you wish to use by clicking on the connection name
from the Connection Name list.

EN I HolidayEyyear

P I a2 7 seconds, comyHolida

Part I

Resource I

(=1 | Save |

| C_onnecktion Mame ﬂ
MationalBank.

[ N

| HolidayByear

HolidayEyonth -
< i

Delete | Mladify Headerl

Note: Active (selected) connections will be preceeded by a yellow arrow.

Inactive connections will be preceeded by a white arrow.
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2. Click the buttonrSend XML.

3. The returned response will appear in the bottom text pane.

45 Transaction Designer - RecorderTest - (ol x|

File Edit Project Window Help

Jes |5 0G| %D =S

=i

HolidaysMonthRequtﬂ <7l version="1.0" encading="UTF-8"7? = -
olidaysftonthRespc <snap:Envelope xmins:soap="http: {{schemas. xmlsoap. org/soap/envelope™ xmins: mrns0="urn:xmethods-CurrencyExch
olidaysyearReques <snap:Body soaprencodingstyle="http: ffschemas, xmlsoap. orgfsoapfencoding =

lidanYearh =mrnsl:getRate >

bt 0 <rountryl xsi:bype="xs:string"=United States <fcountryl =

urrencyRequest.xr <rountry? xsi:bype="xs:string" =Lithuania < jcountryz =

urrencyResponse. : «fmrns0igetRake =

tockRequest., xml <fsoap:Body =

tockResponse <lsoap:Envelope >

nglishToSpanishRec
nglishToSpanishRe:
ipToCibyRequest xr
ZipToCityResponse, —

4 3 _’j
4| | 3
CoHTTR IR (Mo |y T O |
A =Im (e Ak LI =ink t

Mame I
CurtencyExchage < 7eml wersion="1.0" encoding="UTF-&"7 =

a
P Im <soap:Envelope xmins:soap="http:/fschemas. xmisoap, org/soapfenvelope™ xmins:xsi="hktp: [ fwww, w3, org /2001 fXMLEC
: . <soapBody =
Ptk I <n:getRateResponse xminsin="urn:xmethods-CurrencyExchange" =

<Resul: xsi:bype="xsd:float" =2 6445 < fResult =

Resource I <inigetRateResponse =
</s0ap;Body =
=] | Save | < lsoap:Envelope =
| Connection Mame: *l

Lioiti= N R = R |

rt..') CurrsncyExchags - -
1] | » 4 | 3

I
Delete | Madify Headerl TAPOT FESPOTSE |

Import XML Response
1. To save the XML returned by the server as an imported document (for later

use in a response), click thaport Responsebutton located at the bottom of
the screen.
2. Name the response and clioK.

‘:, Enter Mame For Response El

Erter a name For this response

K I Zancel

3. The response will appear in the Imported Docs view.
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£, Transaction Designer - test456 100 x|
File Edit Project ‘Window Help
|ea|® OGEo| W] %
= o [0
[{Zimported Docs 23 | T O | ST S =0
i nextSereen.xm <7xml wersion="1.0" encoding="UTF-8"7> |=]
fee nextScreend, xml < |-- DOCTYPE screenset-transaction -- = <screenset version="2.0" >
«<screensetname value="nextScreen” [ »
<request

<screenname value="Results, 1" /=
«figld name="field14" value="f" /=
<aidkey value="@E" | =

<frequest =

<request:
«<screenname value="Results, 2" />

<frequest =

< /screenset =

<
oprte 22 (Mg = O
Send ¥ML | Impaort Request I

Tdame: I

P I
Port I
Resource I

[ | Save |

I Connection Mame

S ENNE

Delete | Madify Headerl Impaort REsponse | Clear Responsel

Lo

i

4. To switch back to the Transactions view in order to utilize the XML document

in your transaction, click on the open a perspective bl,E,})and choose

Other > Designer or from the menu bar choose, Window > Open Perspective

> Transactions.
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Create a New Transaction

45 Transaction Designer - test456 1Ol =]
File Edit Project window Help

Jea| & D G| =
ﬁgEDesigner

EES Imported Docs X = B || G Transaction &2 lGraph | Content| = 0 || request &2 lResponse| =08

5 Transactions &2 =0

(7 Rules 52 lBranches | Problems| = ﬁ

. . = . .
1. In the toolbar menu, click on the New Transaction bul = :or in the file
menu, choos@roject > New Transaction

2. Enter a name for the Transaction and c@dk.

Mew Transaction X|

Enter a name For the kransaction:

| Tteml

Ik E% I Cancel

3. The transaction will appear in the Transactions view.
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Configure a Transaction

When a Transaction is selected, the transaction will appear both in the Tansacti
view and the Graph view.

45, Transaction Designer - test123

=10 %]
File Edit Project Window Help
lew | B 0@ [ W] X
%} EE Designer
= Imported Docs E@l =8 <:=={>Transaction - Iteml 23 lGraph | Content| = 0O || = Request &2 lResponse| =0
| [Z] laginaml =[] Request/Responses Block
-0 Mo Request Defined
i[5 RESpONSEs
2
m|
(?) Rules 53 lBranches | Problems| =0
Add Rule | Delete Rule |
|.1F output Field |1 |
| | 2

The transaction is initially set up with one Request/Responses Block (or simply

Block). A Block is a request followed by one or more response. To add a Block to a

Transaction, click on the Add Block icon in the toolt L]

A Transaction is initially set up with one Block containing one Response. To add a

Response, select the imported document to be used and click on the Add Response

button in the toolbal 'i::' . To add a Request, select the imported document to be used

and click on the Add Request button in the tool o
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Note: A Transaction Blocknustcontain at least one Request and can also contain

one or more Responses.

Define Requests
Requests are the XML documents used to exchange information with the host or

server. Defining the Requests uses the element and attribute informatiaimedi
the XML or DTD.

In a Request, elements and attributes can be udagdwtg-ields Input fields are
populated by the calling application (which invokes addInput on the Transaction

Processor) with any data that will be sent to the server application.

To define a Request, you must first have an XML document imported. See “Import

XML Documents” for details.

1. Select an XML document from the Imported Docs view. Click on the desired
file and drag ibnto the Request Arrow.

2. The arrow will change from white to green and the name of the XML
document or DTD will appear next to the arrow.

ElI:l Request/Responses Block,
7 login

------ = Responses

View a Request
1. Inthe Request view, you will see the XML root element.
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‘:, Transaction Designer - kest123

File Edit Project ‘“Window Help

-0 x|
Jew| S O G U] %
%} EE Designer
= mported Docs 22 l = B |5 Transaction - kem1 52 lGraph | Content|
|_|55| login. sl E||:| RequestResponses Block
| [E] logaut. xml C::) lagin
o[ REsSponses
5. Transactions 53 =0
. itemi

= &dd Input | Remaowe Input |
(71 Rules &2 l Branches | Problems |

=0
Field Mame | Field Yalue | WPath
Add Rule | Delete Rule |
| If Qutput Field |1s |
4| |
1]

ﬂ Resource I

2. Click on the + sign to the left of the Element to expand and view the other
Elements and Attributes (Sub-Elements). An Element is represented with the

(insert) icon and an Attribute is represented with the (insert) icon.

Request =B

b @ wersion
#- B screensetname
- request

Note: A Request must contain at least one Input field. Follow the instructions in
the following section to add an input field.
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Configure the Resource

A resource is the relative path (after the IP address and port of a URL) to the host
application. Each separate request may be sent to a different resource arethe sa

host.

Resaurce I

A new Request will be assigned a default resource (“resourcel”).

The resource can be edited. However, the value given to the resource must
match exactly the resource name as configured in the Transaction Processor

Add an Input Field
First you will need to view the request, as described in the View a Request. To

designate an Element or Attribute as an Input Field, select the Element or

Attribute in the Request panel and click At meut Field
The Element or Attribute Field Name, Field Value and XPath will appear in the

pane below:

Remove Input Field |

Field Mame | Field Walue | #Path
screensetl.,.. 2.0 |screenset
| | i

Use the scroll bar at the bottom, to view the entire information.

To remove the Input Field, click ddemove Input Field
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Define Responses
Responses are the XML documents used to exchange information with the host or

server. Defining the Responses uses the element and attribute informataanezbnt
in the XML.

In a Response, elements and attributes can have any of the following functions:
o Output field contains data that will be returned to the calling application
(which invokes getOutput on the Transaction Processor).
o ldentifier. used to uniquely identify a particular XML document returned by
the server application.

Note: An Element or Attribute can be used as both an output field and an identifier.

To define the Responses, you must first have an XML document or DTD imported.

See “Import XML Documents” for detalils.

1. To begin defining the output fields and identifiers, you must first select an
XML document from the imported docs panel. Click on the desired file and
drag itonto the Responses folder.

2. An arrow will appear below the folder along with name of the XML
document.

L6, Transaction. ey [ERTI[er
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View a Response

1. Inthe Response panel, you will see the XML root element.

‘:, Transaction Designer - kest123

File Edit Project ‘“Window Help

=10l x|

lew [ & O G| W R

%} EE Designer

[=/mported Docs E@] =4 %Transaction -iteml B2 lGraph | Content| B = peoest - ogin X

JEE login. sl =[] RequestjRespanses Block
B . B
/2] logaut. xml C::) lagin
o[ REsSponses

5. Transactions 53 =0

. itemi

= &dd Input | Remaowe Input |
(71 Rules &2 l Branches | Problems |

Field Mame | Field Yalue | WPath
Add Rule | Delete Rule |
| If Qutput Field |1s |
4| |
b I ﬂ Resource I
2.

Click on the + sign to the left of the Element to expand and view the other
Elements and Sub-Elements. An Element is represented with the (insert) icon

and an Attribute, or Sub-element, is represented with the (insert) icon.

b @ wersion
#- B screensetname
- request

Note: A Response must contain at least one Identifier and can contain one or

more Output Fields. Follow the instructions in the following sections to Add
an ldentifier and an Output Field.
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Add an Identifier
First you will need to view the response, as described in the
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View a Response. To designate an Element or Attribute as an Identiket, thel

Element or Attribute in the Response panel and clic Add Identiir |

The XPath for the Element or Attribute will appear in the pane below.

Remove Identifier

Identifier ¥Path
Iscreensetrequest[1]iscreenname 1])att

a | i

To remove the Identifier, click oRemove Identifier.

Add an Output Field
First you will need to view the response, as described in the

40



Cleo Transaction Designer for XML User’s Guide Using the Transaction Designer

View a Response. To designate an Element or an Attribute as an Output field,

The Element or Attribute Output Field Name and XPath will appear in the pane
below:

Add Qukput Field | Remove Output Field

Qutput Field Mame | #path
srreensetnamez . value Iscreenset)s
l | [

Use the scroll bar at the bottom, to view the entire information.
To remove the Output Field, click &emove Output Field

41



Cleo Transaction Designer for XML User’s Guide Using the Transaction Designer

Element Icon States
o When an Element has been designated as an Input field, the icon changes from

€ o€,

o0 When an Element has been designated as an Output field, the icon changes
from€ to £,

o0 When an Element has been designated as an Identifier, the icon changes from
€ o €

0o When an Element has been designated as an Output field and Identifier, the

icon changes fror€ to £,

Attribute Icon States
o When an Attribute has been designated as an Input field, the icon changes

from @ to & .

o0 When an Attribute has been designated as an Output field, the icon changes
from @ to 4.

o When an Attribute has been designated as an Identifier, the icon changes from
a to &

o When an Attribute has been designated as an Output field and Identifier, the

icon changes fror@ to &

Note: You can also hover over any Element or Attribute to view the Usage and

Value.

Using Branches
A “branching response” is any response returned from the host or serveilthat wi

be different depending on what data is originally sent to the server from the use

For instance, suppose there is a single request document that contains only one

input field:

o If the user sends INPUTA in the request document, then the response
document that is returned from the server will be RESPONSEA.

o If the user sends INPUTB in the request document, then the response

document that is returned from the server will be RESPONSEB.
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o If the user sends INPUTC in the request document, then the response
document that is returned from the server will be RESPONSEC.

In the above case, RESPONSEA, RESPONSEB, and RESPONSEC are uniquely

identified from each other.

Define a Branch
Before a Branch can be defined, a Transaction containing at least one Respons

must be selected. Branches cannot be defined when Rules are defined.

1. Click onAdd Branch in the Branch Panel:

Add Eir.?nch I Delete Branch |
3

| If Response Returned | Fun Transackion |

2. Click in thefirst cell underneath “If Response Returned.”

3. From the drop down box, select the desired Response:

W Prablems =B

#dd Branch | Delete Branch |

| If Response Returned | Fun Transackion |
(7) nextScreend

nexkScreend
nexktscreen
login

4. Click on thecorresponding cellunderneath “Run Transaction.”

5. From the drop down box, select the Transaction that will be invoked.
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w Problems =0

Add Branch | Delete Branch |

| If Response Returned | Fun Transackion |
stepl

P
(7)) nextScreend

CheckBalance

Using Rules
Rules provide conditional control on the transaction. They define which

transitions to follow next based on a comparison on Output fields. (Rules are
optional, but may be used as an alternative to building similar IF-THEN logic int
the user application.) For instance, if there is an Output field that contains a
BALANCE and two transitions each leading to two different request nodes (one
which lists premium account options and another which lists standard account
options), a set of rules might be defined that states:

“If BALANCE is greater than or equal to 100000, then follow transition 1”

“If BALANCE is less than 100000, then follow transition 2”

Define a Rule
Before a Rule can be defined, a Transaction containing at least one Output field

must be selected. Rules cannot be defined when Branches are defined.

1. Click onAdd Rule in the Rules Panel.

(7)Rules 2 lBranches ‘ Prublems| ="

F\dd&ule | Delete Rule |

| If Outpuk Field | Is | Value | Run Transaction |
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2. Select the desired Output Field.

w Eranches | Problems =
Add Rule | Delete Fule |
I If Oukpuk Field | Is | Yalue I Fun Transackion
|:'E‘:| £l i EI:]LIEI' Ta
3. Choose the condition.
w Eranches | Problems |
Add Rule | Delete Rule |
| If Dutput Field | Yalue | Fun Transackion
(7) screenset!.version
|Greater Than
Greater Than [ Equal To
Less Than
Less Than f Equal To
4. Enter the value.
m Branches | Problems = 0O
add Fule | Delete Rule |
| If Qukput Field | Is | Walue | Fun Transackion
(7) screenset!.version Equal Ta I
J | i

5. Select the Transaction that you wish to run based on the Rule.
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w Branches | Problems =0

Add Rule | Delete Rule |

| If Cukput Field | Is | Yalue | Run Transackion
stepl

(7) screensetl.version Equal To 100

Problems
The problems tab lists any errors in the current Project that will cawskatinvalid,

or not able to be published.

Rules | Branches [LPru:uI:uIems &3 =0

Descripkion | Transackion | In Request/Response &

& 23490 - 4 block must conkain 1 request,

3 23484 - & response must have at least 1 identifier,
3 23484 - & response must have at least 1 identifier,
3 23484 - & response must have at least 1 identifier,
& 23490 - 4 block must conkain 1 request,

& 23490 - 4 block must conkain 1 request,

& 23490 - 4 block must conkain 1 request,

(8 23486 - Response does nok contain oukput Fields
(8 23486 - Response does nok contain oukput Fields
(8 23486 - Response does nok contain oukput Fields

stepl

stepl f',:l nextacreens
stepl f',:l nexkacreen

stepl f',:l login

Logout

CheckBalance

AvailableCredit

stepl f',:l nextacreens
stepl f',:l nexkacreen

stepl f',:l login i

P P A IR e

8 23483 - Block does not contain a response, Logout
.f_l*i23483 - Block does not contain a response, . ZheckBalance I_ILI
4 3

For details on problems and resolution, see “Appendix A: Troubleshooting”.
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Modify an Existing Transaction

Cut, Copy, and Paste
Requests and Responses can be Cut, Copied, and Pasted by right-clicking on the

specific Request or Response.

5. Transaction - ikemi 22 | Graph | Cantent

ElI:l Request|Responses Block,

lnin

P
Rename

Note: Responses cannot be pasted into Requests and Requests cannot be pasted into

Responses.

Rename a Request or Response
Any request or response can be renamed by right-clicking on the specjiesRer

Response in the Transactions view and choosing Rename.

“5. Transaction - item1 &2 | Graph | Content

ElI:l RequestiResponses Block,
7 login
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Change the XPath
In some cases, it may be desirable to change the XPath for input fields, alts,toi

identifiers to something more advanced in order to account for repeating, Huirona
moving attributes or elements. Simply click on the XPath cell in a table containing

identifiers, output fields or input fields and type in the new XPath.

Output Field Mame | #Path
Bookz0 poksResult] 1 Book[ 20

4 | ]
add Identifier | Remove Identifier |

Identifier ¥Path

[Envelope

4 | 2]

For more information on XPath referhttp://www.w3.org/TR/xpath

Rename input/output fields
In order to rename an input or output field, simply click on the cell containing the name

of the field and type in the new name.

Output Field Mame | #Path
Fookz0| Isoap:Envelopefsoap:. ..

1 |

add Identifier | Remove Identifier |

Identifier ¥Path
[Envelope

< |
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Rename a Transaction
To change the name a Transaction, right click on the transaction in the Tiansact

view and choosRename
=N

...... <}~==;'> m
Renarme |

s

Enter the new name of the Transaction and ¢ligk

Rename Transaction ﬂ

Please enter a new name:

I CompanyInfo

Ik I Cancel

L

I o [N o 1810}

Delete an Existing Transaction
1. Click on the transaction in the Transactions view.

2. Click on the delete button located in the tooI!,‘, or use the menu batdit

> Delete
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Publish a Transaction

When a transaction is complete, it can be published. The associated transactions are

first checked for errors and then the required files used by the Transacic@s$or

to run the transaction are created. To publish a transaction click on the Publish icon

Al in the toolbar or use the program meRtpject > Publish.

The status bar at the bottom of the workbench will show the publishing status.

‘__, Transaction Designer - teskt123

File Edit Project ‘Window Help

Jea| & 0@ | W]
ﬁgEDesigner

=10l ]

|{=/Imparted Docs £2 =0 <':==D

Transaction - iterml £2 lGraph | Zonkent |

= O ||request - I... |<~Response-... &2 | = O
=] login.xml B[] RequestiResponses Block oy —gp—
| E] lngout.xml C::) lgin L@ )
[} Responses g S VEFSION
£ lngout - screensetname
C O value
@B request
5. Transactions 3 =0
5, itemt
Add Output Field | Remaove Oukput Field |
M Branches | Problems| =0
Oukput Field Mame | wpath
Add Rule | Delete Rule | screensekl  version [screenset)|:
| | i
| 1f Cukput: Field | Is | e Add Identifier | Rermowve IdentiFierl
Identifier ¥Path
Iscreenset/screensetname] 1]/ attribute:
1 ma IE A i pai

Publishing transactions. ..

Transactions are now ready to be used by the Transaction Processor (see the

Transaction Processor Admin Guide and Transaction Processor Programmee’s Gui

for details on using the Transaction Processor.)
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If the transaction contains errors, a warning message will be displayed:

Project Contains Errors EI

Q 23488 - Transactions could not be published, Project conkains errors,

If this occurs, review and fix the errors as identified in the Problems Panel.

For details on problems and resolution, see “Appendix A: Troubleshooting”.

Transfer the Published Transaction Set

Once the Transaction Set has been published, the TD can be used to copy the files

required by the Transaction Processor into their runtime locations.

To transfer the published transaction set to either a local network driverooger

location, from the file menu, chooBeoject > Transfer Transaction Set

":, Transaction Designer - test123
File Edit | Project “Window Help

J B3 | E= xy Import XML document or D0

O—
2] | o= DE "5 Create Mew Transaction
= Import [ | Add Black ti
| =] I« Add Response I
. lo = Add Request I

LIl Publish Transactions -

B3 Transfer Transaction Set

[ = |=|]

A new window will open. The first time you utilize the Transfer feature, yilu w
need to name and define the transfer settings. In the future, you will be ablizeo ut

saved transfer settings.
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B2 Transfer X|

Transfer Settings

Transfer Type
’VF Local © Remoke

Huosk/IFURL Port:
| 21
Username
Password
) 3
Directary [

I Browse | ;

Mew Setking Delete Setting Save Setking | Transfer | Close |

Enter aname for the transfer setting.
Select eitheL.ocal or Remotefor the Transfer Type.
If Local, type in or Browse to find the directory path.

If Remote, enter the Host/IP/URL, Port, Username, and password.

a bk~ w0 N

Click Save Setting The saved setting will now appear in the left side of
the window under ‘Transfer Settings.’

6. Click on the Transfer Setting you wish to use and clicnsfer.
To Delete a Transfer Setting, click on the setting to be deleted andeliete

Setting. To create an additional transfer setting, cNgw Setting To exit the

window, clickClose
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Pulling It All Together

Now that you have read about all the different features provided by the Transacti
Designer for XML, you should be ready to create your first Transactiopr§ect.

In this section, we have provided a simple example that should help pull much of what
you've learned together. For this example, you will be creating a ttaors#wat will
obtain the state for a given ZIP code.

To create a Transaction Set project:

1. If the TD is not licensed, install a license (see “License the Transaction
Designer”).
Launch the TD for XML.
Enter a name for the new project — ZipService (see “Create a New Fbojauy
Startup”).
4. Switch to the Recorder Perspective (see “Access the XML Recorder”).
5. Create a new HTTP connection (see “Create an HTTP Connection”).
a. Name: ZipService
b. IP: http://webservices.imacination.com/distance/Distance.jws
6. Modify Header for ZipService (see “Modify HTTP Header”).
a. Content-Type = application/soap+xml; charset=utf-8
b. SOAPAction =*”
7. Record the XML documents that will be used in the transaction.
a. Send the following XML request to the configured Web Service (see
“Send XML to the Server”):

w N

<?xm version="1.0" encodi ng="UTF- 8" ?>
<soapenv: Envel ope xml ns: soapenv="htt p://schemas. xn soap. or g/ soap/ envel ope/ "
xm ns: xsd="htt p: // www. w3. or g/ 2001/ XM_Schena" xm ns: xsi ="http://ww. w3. or g/ 2001/ XM_Schena-
i nst ance" >
<soapenv: Body>

<nsl: get St at e soapenv: encodi ngStyl e="htt p://schemas. xm soap. or g/ soap/ encodi ng"
xm ns: ns1="http:// Def aul t Nanespace" >

<nsl:zi p>48103</ nsl: zi p>

</ nsl: get St at e>
</ soapenv: Body>
</ soapenv: Envel ope>

b. The following XML response should be returned:

<?xm version="1.0" encodi ng="UTF- 8" ?>
<soapenv: Envel ope xml ns: soapenv="htt p://schemas. xm soap. or g/ soap/ envel ope/ "
xm ns: xsd="htt p: // www. w3. or g/ 2001/ XM_Schena" xm ns: xsi ="http://ww. w3. or g/ 2001/ XM_Schena-
i nst ance" >
<soapenv: Body>
<nsl: get St at eResponse xni ns: ns1="http:// Def aul t Nanespace"
soapenv: encodi ngStyl e="htt p: // schemas. xm soap. or g/ soap/ encodi ng/ " >
<nsl: get StateReturn xsi:type="xsd:string">M </ nsl: get St at eRet ur n>
</ nsl: get St at eResponse>
</ soapenv: Body>
</ soapenv: Envel ope>

c. Import the request (see “Optionally Import XML Request”). Name the
request “GetStateRequest”.

d. Import the response (see “Import XML Response”). Name the response
“‘GetStateResponse”.
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e.

Clear the response.

8. Switch to the Designer Perspective.

9. Create a new transaction (see “Create a New Transaction”). Martransaction
‘GetState”.

10. Define the Request and Response that will be exchanged with the Web Service
when the ZipTrans transaction is run.

a.

b.

Add a request to the first Request/Responses Block using the
GetStateRequest imported doc (see “Define Requests”). Rename request
to “GetStateRequest” (see “Rename a Request or Response”).

Add a response to the first Request/Responses Block using the
GetStateResponse imported doc (see “Define Responses”). Rename the
response to “GetStateResponse”.

11.Define Input Fields that will be sent to the Web Service, Output Fields théewi
returned from the Web Service, and Identifiers that will be used to verify that the
correct response is returned from the Web Service.

a.

b.

C.

Add an input field to GetStateRequest using the “nsl:zip” element (see
“Add an Input Field”). Rename the input field to “ZipCode”.

Add an output field to GetStateResponse using the “nsl:getStateReturn”
element (see “Add an Output Field”). Rename the output field to “State”.
Add an identifier to GetStateResponse using the “nsl:getStateResponse”
element (see “Add an Identifier”) .

12.Publish the transaction set (see “Publish a Transaction”).
13.Transfer the transaction set (see “Transfer the Published Transactijon Set
14.View the transaction map (see “Appendix B: Transaction Map”).

The “GetState” transaction can now be run in the Transaction Processor.
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Appendix A: Troubleshooting

Problem Descriptions

The following warnings (that may or may not not need to be corrected) and(drabrs

prevent transactions from being published) are documented in the Problems view.

Descripkion | Transacl
323490 - A block must contain 1 request, f'n; M
{2 23483 - Block does not contain & response. S Newl

23477- A transaction must be selected before adding a block.
Simply click on the transaction you wish to add a block to, then add the block.

23478- Cannot add block, conditions are defined.

Since conditions such as Branches or Rules can only exist on the last block in a
transaction, blocks cannot be added to a transaction after conditions have been defined.
If you wish to add additional blocks to this transaction, you must first delete the

condition.

23479- Both an imported doc and a block must be selected before adding a request.
Click on the imported doc to be used as a request and then click the add request button on thar too

drag the document over to the request area of the desired transaction.
23480- Both an imported doc and a block must be selected before adding a response.

Click on the imported doc to be used as a response and then click the add respomss baé toolbar,

drag the document over to the responses folder of the desired transaction.
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23481- Failed to import document due to the following error

Generally caused by attempting to import a file that is not well-formed XM

23482- Only one imported document can be added as a request.

A transaction can only have one request.

23483- Block does not contain a response.

A valid transaction must contain at least one response.

23484- A response must have at least 1 identifier.
A valid response must contain at least one identifier to distinguish it from other

responses.

23485- Request does not contain input fields.
In most cases, but not all, requests have at least one input field to be sent to the
host/server application. It is not necessary to provide an input field, but this igfegge

a warning since in most cases it is common for a request to have one.

23486- Response does not contain output fields

In most cases, but not all, responses have at least one output field specifgstpfled
extracted from a document received from a host/server application. Itriscessary to
provide an output field, but this is flagged as a warning since in most cases it isromm

for a response o have one.

23484-This project does not contain any transactions.
In order to publish transactions, there must be transactions to publish. See section on

creating transactions.
23488- The following transactions contain errors and will not be published...

If a transaction contains errors, it will not be published. Check the problems viewstoofaekrors for

more details.
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23489- There are warnings in the project. Continue with publish?
Transactions that contain warnings are still publishable, however you mayovzdreick

the problems view for more details on the warnings.

23490- A block must contain 1 request.
A block must contain at the very least a request to be sent to the host/servetiapplica
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Appendix B: Transaction Map

A file containing a list (i.e. “mapping”) of all transactions and requeslsnse

definitions currently defined in the Transaction Set project is published eacth@me t
Transation Set is published. This file can be used by the developer of the apptati
determine which transactions to invoke on the Transaction Processor and what input to
send to/output to retrieve.

To view the Transaction Map, select Window | Show View > Transaction Map. The

Transaction Map can be printed by right-clicking anywhere in the teatand selecting
Print.

Sample Transaction Map

Transaction Set: XMLSample

Transaction: GetCity
0 Error(s) 0 Warning(s)

- Request/Responses Block 1 -

Input Field - zip
Value||48103
[*[local-name()="Envelope’]/*[local-name()='"Body'][1]/*[local-
name()="getCity'|[1]/*[local-name()="zip"][1]

Response = GetCityByZipResponse

XPath

Output Field - city
[*[local-name()="Envelope’]/*[local-name()="Body'][1]/*[local-
name()='getCityResponse'|[1]/*[local-name()="getCityReturn'][1]
Identifier

[*[local-name()="Envelope’]/*[local-name()='"Body'][1]/*[local-
name()="getCityResponse’[1]

- End of Request/Responses Block 1 -

XPath

XPath
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Glossary

Attribute: In an XML document, a sub element defined within an element. In the
following example, GENDER and AGE are attributes within the PERSONegliem
<person gender="male" age="36">
<firstName>Bob</firstName>
<lastName>White</lastName>

</person>

Element: A logical structure in an XML document that is delimited by a start and an

end tag. Also called an XML object.

Identifier : Used only in Responses, used to uniquely identify a particular XML

document returned by the server application.

Input field : Used only in Requests, populated by the calling application (which
invokes addInput on the Transaction Processor) with any data that will be sent to the

server application.

Keyboard macro: variable text stored in a table to be used as input in a host
transaction sequence. Each entry is referenced by column number when defining “to

host” field definitions.

Output field : Used only in Responses, contains data that will be returned to the
calling application (which invokes getOutput on the Transaction Processor).

Partial Publish: When using the publish function to create the XML files for screen

definitions and transactions, the XML file could not be generated for any ttiansac

containing screens with no identifiers.
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Right click: the action of using the alternate mouse button.

Transaction Set a collection of transactions and XML documents used by the
Transaction Processor. A transaction set may be assigned to one or mons.sess
For example if “tsetl” is assigned to sessions 2-11, “tset2” is assignessionsel 2-

31, the IR application “irl” which runs “tsetl” is assigned to channels 0-9, the IR
application “ir2” which runs “tset2” is assigned to channels 10-19, and the IR
application “ir3” which also runs “tset2” is assigned to channels 20-29, then when a
call is made into channel 1, “tsetl” will be run. Likewise, if a call is maae int

channel 11 or channel 25, “tset2” will be run. (See also Application)

User-defined transaction contains host transaction sequence that is run by the
Transaction Processor when requested by the IR application to retrieve iidarma
from the host. An empty user-defined transaction named “transactionl” iscchsat

the Transaction Designer.
XML : short forExtensibleMarkup Languagea specification developed by the
W3C. XML is a pared-down version of SGML, designed especially for Web

documents.

XPath: a language that describes how to locate specific content contained within an

XML document. XPATH treats an XML document as a logical ordered tree.
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